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Introduktion 
 
Velkommen till BERNINA® Broderi Software, det førende 
broderi/design-program for hjemmebrugere. Dette er et MS 
Windows®-baseret produkt som bruger  det konventionella PC-
sprog som mange allerede kender til. BERNINA Broderi 
Software er unikt og gennemarbejdet, så at du enkelt kan skifte 
til CorelDRAW® Essentials X6 via Corel Corporation, det mest 
populære vektor-baserede tegneprogram for hjemmebrugere. 
Denne kombination byder på en mere effektiv at skabe 
broderidesigns ved at kombinere den broderi-tekniske 
kapacitet fra BERNINA Broderi Software med den grafiske 
kapacitet fra CorelDRAW®. Det gør det også muligt skabe, ikke bare broderi, men et utal af  
designs bestående af manga forskellige tekniker.  
 

 
Notér CorelDRAW®Essentials og søsterproduktet, Corel PHOTO-PAINT® Essentials X6 kan også 
anvendes separat. En komplet beskrivelse af værktøjer og egenskaber finder du i User Guiden via 
Windows Start > Programs gruppen. Alternativt kan man anvende onscreen help via Graphics 
logoet og Help menuen 
 
Første-gangs brugere 
Hvis du er ny bruger af BERNINA Broderi Software, kommer du hurtigt til at blive glad for de 
fleksible stingsætningsmuligheder, enkeltheden i hvordan du kan skabe og redigere designs, og 
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hvor enkelt det er at tilføje til projektet eller lave en tekst. Men, inden du anvender softwaren, 
læs venligst Kom godt i gang på side 6. 

 
Update brugere 
BERNINA Broderi Software er en forbedret version af vores tidigaere produkter. Den har mange 
nye og udvidede egenskaber. Læs venligst i Release Notes fra Help menuen for at se de 
forbedringer fra tidligere version. 

  

Security device / dongle 
 
BERNINA Broderi Software sikres af en sikkerhedslås / dongle. Denne skal være isat din PC, 
ellers vil programmet ikke fungere. Hver eneste dongle har et unikt  
serienummer og identitetskode, så dit system kan genkendes. 
Dongelen er den mest værdifulde del i dit system og skal håndteres 
varsomt. Gem den altid et sikkert sted, når den ikke er i brug. Dongelen 
omfattes af garanti mod brister i materiale og brug, ved korrekt anvendelse 
og installation, 12 månader fra og med købsdato. Men, forsvinder den, 
eller bliver stjålet, så kommer du til at købe et helt nyt BERNINA Broderi 
Software for at kunne arbejde videre. Det er en god idé at forsikre din 
dongle.  
 

Installere software-programmet 
 
Installationsprocessen lader dig vælge: 

►      Om software-programmet og alle designs installeres på din PC/netværk. 
►        Hvilke dele som skal installeres – f.eks. flere sprog, BERNINA Portfolio e t c. 
►        Hvilke dokumentations-filer som installeres. 
          Hvis du opdaterer din software, så behøver du IKKE afinstallere den tidigere version. Lad 
          installationsprocessen gøre dette for dig. 
 
 

Sådan installerer du software-programmet 
►      Luk alle andre programmer på din computer. 
►        Du skal ligeledes lukke din firewall og anti-virus program, for at være sikker på at programmet 
          og alle drivere bliver installeret korrekt. 
►        Sæt i disc’en i dit drev og følg anvisningerne. 
►        Du vil blive informeret om hvornår du skal isætte dongle. Hvis du har et upgrade-kit, 
          Vil du også få besked om når du skal isætte din gamle dongle. 
 

           
 
►        Hvis din PC allerede indeholder en eller flera ældre versioner af BERNINA Broderi Software: 
 

          ►       Så bliver du spurgt om den tidligere version, som den nye skal installeres oveni. 
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          CorelDRAW® Essentials X6 installeres som en del i den normale installation. 
 

►        Du får derefter et valg om at start PC’en med den nye installation. Genvejs-ikoner bliver så  
          placeret på MS Windows® skrivbordet og på følgende plads; Start > Programs gruppen. 
 

►        Åbn BERNINA Broderi Software. 
          Hvis du har lavet nogle ændringer i din gamle BERNINA Quilters stof-bibliotek, så bliver de                       
          installeret med den seneste installation. Installationen overfører også bruger- 
          kreérede mønstre eller motiver. 
 

Hjælp & support 
 
BERNINA Broderi Software tilbyder flere former for hjælpeinformationer om software-
programmet og hvordan man anvender det. Der findes også link til kilder med færdige broderi-
motiver. 
 
   Adgang til 

onscreen manualer 
 
 
 
 
Adgang til BERNINA og 
OESD broderi/design studios 
 
 
 
Køb og installér opgraderinger 

 
    

Onscreen Manual 
Alt afhængig af din software, kommer disse manualer at inkludere dele af, eller følgende: 
 
Release notes 
Denne oversigt installeres automatisk , og beskriver de nye og forbedrede egenskaber i den nye 
version af programmet, samt links til relevante dele i ”Reference Manual”. 
 
Reference Manual 
I manualen finder du detaljerede beskrivelser af alle dele og funktioner i BERNINA Broderi 
Software ’Embroidery Canvas’. Programafsnittet BERNINA Cross Stitch og BERNINA Quilter 
findes  i seperate  tillægsmanualer. 
 

 
Notér En komplet beskrivelse af CorelDRAW®-værktøjet som findes i ’Artwork Canvas’, finder du 
i den elektroniske User Guide/brugerguiden som er tilgængelig via; Windows Start > Programs 
gruppen. Alternativt, anvend onscreen help, som du finder via Graphics og så Help menu. 
 
Onscreen help/hjælp 
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Onscreen help giver dig hurtig adgang til almen information om BERNINA Broderi Software-
funktioner og step-by-step instruktioner. Trykker du <F1> får du en yderligere beskrivelse. 
 
 
 
 
 
 
 
 
 
 
Yderligere hjælp 
Med din BERNINA Broderi Softwareinstallation, får du yderligere hjælp til de følgende 
programmer: 

 
►      BERNINA Cross Stitch: Denne beskriver hvordan du anvender funktionerne i det specielle 
          BERNINACross Stitch-program.  
►        BERNINA Quilter: Denne beskriver hvordan du anvender funktionerne i det speciella BERNINA 
          Quilter-program. 

 

Online Broderier 
Det findes mange sæt broderi-motiv/designs som du kan køba og anvende som du ønsker. Dit 
BERNINA Broderi  Software videresender dig til to kilder – BERNINA og OESD embroidery design 
studios. 
 

 

Software opgraderinger 
 
Du kan opgradere dit BERNINA Broderi Software direkte via Help-menuen som blev vist tidligere. 
Når du har kontakt til BERNINA forhandleren, så skal du altid du angive dit Dongle Nummer. Du 
kan også bruge Serial Nummer og Identity Code. Denne information finder du direkte på 
dongelen. 
Informationen kan også findes under Security Device 
Options dialogen som du finder via Settings-menuen. 
Online opgraderinger kan foretages via Purchase Upgrades 
on the Internet punktet under Help-menuen. Denne 
hjemmside tilbyder forskellige opgraderinger alt afhængig 
af softwaren på din gamle version. Hvis donglen har 
BERNINA EditorPlus, så vil du blive tilbudt en opgradering til 
BERNINA DesignerPlus. 

 
 

  
Advarsel Hvis din browser har et for højt sikkerhedsniveau, er det ikke sikkert du kan få lov at 
hente opdateringerne. Oplever du disse problemer, sænk da sikkerhedsniveauet til medium. 
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Kom godt i gang 
 
Hvis du er helt ny indenfor BERNINA Broderi 
Software eller maskinbroderi, spørger du sikker 
dig selv ’hvordan gør jeg?!’. Ét er sikkert og det er 
at du kommer til at bruge mange timer, både glad 
og måske lidt frustreret under indlæringsperioden 
af hvordan du får det meste ud af din BERNINA maskine og 
dette softwareprogram. Dissa to arbejder hånd-i-hånd og 
der behøves træning og tålmodighed for at behærske både 
at skabe og designe et perfekt broderi. 
Resultatet taler for sig selv. Og jo mere tid du bruger, desto 
bedre bliver dine broderier. Med hvert eneste projekt som 
du gør færdigt, kommer du et skridt nærmere erfaring og 
sikkerhed.  

 

Begynd i den rigtige rækkefølge 
 
Du behøver ingen tidligere erfaring for at begynde med BERNINA Broderi Software. Du kan  
enkelt åbne er design og sende den til maskinen for at ’brodere ud’. Og dette er det bedste  
måde at begynde på. Når du er blevet lidt mere erfaren kommer du til at kunne  ’aflæse’ 

          anderledes designs og kunne se hvilke der er god kvalitet, og hvilke der kun vil give problemer. 

 
Eksempel designs og artwork 
BERNINA Broderi Software indeholder hundredevis af 
færdige-til-at-sy motiver, inklusiv mange flotte 
ornamenter, eksempeldesigns og billeder. Designfiler 
(ART filer) og billeder (BMP, JPG, og WMF filer)  
kan findes i My Designs > Embroidery Software 7 
mappen. Det vigtigste som ny, er at få et indblik i alle 
disse funktioner. 
 

 
Notér: Med BERNINA Broderi Software følger dets 
eget BERNINA Portfolio motivhenter for at kunne 
håndtere motiverne let. Alternativt, kan man bruge 
designmapperne i MS Windows®Explorer. 
 

Andre kilder 
Der findes mange andre kilder med færdige 
broderimotiv som du kan købe og anvende som du vil. 
Din BERNINA Broderi Software henviser til to kilder – 
BERNINA og OESD embroidery design studios.  
 

Clipart 
Med CorelDRAW®Essentials X6 medfølger clipart som du 
du finder via Program- 
gruppen. Sæt dig ind i clipart delen. Mange kan 
redigeres og 

Link tll BERNINA &  
OESD embroidery  
design studios 

Her finder du CorelDRAW® 
clipart-mapper. 
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anvendes til broderi-designs, enten som udgangsbillede eller for direkte stingsætning. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

For at gøre arbejdet så nemt som muligt, kan du kopiere hele CorelDraw®Essentials X6 Clipart-
mappen og gemme den i My Designs > Embroidery Software 7-mappen for lettere at kunne 
finde den. 
 

  
Advarsel! De inkluderade artwork-billeder (clipart) og broderi-motiver må kun bruges til privat 
brug – og må ikke anvendes i kommercielle sammenhænge, ifølge reglen om ophavsret. 
 

Regler for et godt broderi 
Kontrollér følgende punkter når du gennemgår et broderi, både dit eget eller andres: 

          ►       At stingene ligger korrekt, jævnt og plant. 
          ►       At designet ser godt ud – former, farver, balance. 
          ►       At formerne er fyldt med korrekte fyldningssting og kontursømme. 
          ►       At stingvinkelen ligger i bedste vinkel i forhold till formen. 
          ►       At stingene er syet uden uønskede mellemrum. 
          ►       At alle detaljer er tydlige. 
          ►       At tekst er tydelig og enkel at læse. 
 

          Et færdigsyet broderi bør også ses på følgende måde:  
 

          ►       At designet sys effektivt på maskinen. 
          ►       At tøjet ikke ”bobler op” omkring de syede områder. 
          ►       At der ikke er løse tråde i designet. 
 

           
          God broderikvalitet hænger sammen med et godt design. Desuden behøver du en 
          kvalitetsmaskine, for at opnå bedst mulige resultat.   
          Men det er også vigtigt hvilket stof, tråd,  
          stabiliserings-materiale, trådspænding o s v. 
          Læs i din symaskines manual for råd og vejledning. 
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Sy et færdigt design 
 
For manga som broderer, er det nemmeste at vælge et færdigt design og brodere. Dette er det 
de fleste starter med. Når du har fundet et design du gerne vil have broderet, vil man gerne se 
hvordan det kommer til at se ud.  

 
 

At sy et design 
►       Åbn designet i BERNINA Broderi Software. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
           ►       Vælg indstillinger til forhåndsvisning. 
 
 
 

 
 
 
 
 

           ►       Tjek stofkvaliteten og ændre indstillinger efter behov via Design > Fabric Settings menuen. 
 
 
 
 
 
 
 

           ►       Tryk Shift+R for at kunne få forhåndsvisning af motivet. (som en film). 
        
 
 
 
 
 
 

 

Stoftype 

Filtype Stingtæller 

Start visningen 

Justere billede 

Stitch range viser hvor i  
motivet du befinder dig 

Send designet til maskinen 
direkte eller via USB 
 

Åbn design 
 

Se det færdige design 
før det bliver broderet 
 

 

Justér indstillingerne 
Til forhåndsvisning 

 
 

Justér zoom 
=vis størrelsen på 

motivet 
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            ►       Send broderimotivet/designet til maskinen direkte via kabel eller via USB-stick. 
                   Læs i din BERNINA manual hvordan du broderer motiver ud. 

 

Redigér et design 
 
Når du er blevet fortrolig med at brodere designs ud – enten clipart eller andre du har købt – så 
kommer du snart til at ville ændre på egenskaber såsom størrelse, skifte trådfarver og 
stofkvaliteter. Disse er relativt lette ændringer. 

 
At ændre et helt design 
►       Åbn det design du ønskar at arbejde med og klik på det, for at vælge det (Select). 

          ►       Kontrollér størrelse og ændre evt. Eks.; om du skal brodere et design til venstre bryst, så         
          bør størrelsen være max  

ca 108mm i kvadrat 
 
 
 
 
 

           ►       Ændre trådfarver efter ønske. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
s 
 
 
 
 
 
 
 
 
 
           ►       Kontrollér stofkvalitet og ændre evt. via Design > Fabric Settings menuen. 
 
 
 
 

Vælg og brug ønskede farve 
Skift mellem flere 

farvekombinationer 

skift tråd 

Vis ramme 

Kontrollér dimensioner og 
ændre størrelse 
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           ►       Vis rammen. Hvis du højreklikker på symbolet, kan du også skifte/vælge størrelse på rammen. 
 
           ►       Vælg Design > Background menuen for at se designet direkte på en beklædningsgenstand.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
           ►       Send designet till maskinen direkte eller via et USB-stick. 
 

Lav et enkelt tekst-design 
 
Når du er fortrolig med at brodere designs, ændre størrelser, skifte farver og ændre 
stofkvaliteter, så kommer du definitivt til at selv ville skabe dine egne tekst-designs. Det kan 
tage lidt tid at lære at få en god kvalitet på broderiet, men det er ikke sværere end at skrive på  
selve maskinen. 

 
 

Lav et enkelt tekst-design 
►       Åbn et design. Det mest normale  
         er at tilføje teksten til sidst, i et                      
         færdigt design. 
►       Tilføj broderi-tekst til designet 
         direkte på skærmen. 
 
 
 
 
 
 

 
►       Højreklik på tekstværktøjet hvis     
         du vil ændre på indstilligerne. Det er enkelt 
         at justere basislinjer, tekstformat, afstand og farver. 
 
 
 
 

Tilføj broderitekst 
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►       Brodér dit tekst-design. Se efter stingkvaliteten. Vær opmærksom på at alfabetet vil blive  
          pænest i visse størrelser. 
 

Lav et monogram-broderi 
 
BERNINA Broderi Software gør det 
nemt at skabe monogram-designs med 
’alt-i-et’ værktøj Monogramming tool 
som du finder under Lettering tool. Du 
kan vælge skrifttype, ornament og op 
til fire spejlede kanter (bårder) 
omkring designet. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lav et broderi automatisk 
 
Når du er blevet fortrolig med programmet, du kan allerede lave en hel del uden faktisk at lave 
dine egne designs eller stingsætningsarbejde. Men nu er du kommet så langt at du vil lave dit 
eget! 
En af de hurtigste måder at komme i gang på er at anvende de automatiske teknikker som 

Justér basislinjen, 
tekstformat etc. 

Bårder sys i rækkefølge –  
1, 2, 3 e t c 

Ornament sys 
efterfølgende 

Vælg de forskellige faner i 
Monogramming-boksen for 
at ændre indstillinger for 
tekst, ornament og bårder. 

Tekst broderes sidst 
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BERNINA Broderi Software indeholer. Der findes dog også begrænsninger i disse. Men 
metoderne tillader dig hurtigt at få lavet dine broderier relativt hutigt færdig, med dine egne 
design-idéer og måske er det målet for dig.  
 

Konvertere Vector artwork 
Det specielle værktøj i BERNINA Broderi Software laver automatisk et vector-objekt og tekst til 
et broderi eller et tekst-broderi. Disse kan efterfølgende redigeres. 
 
 
 
 
 
 
 
 
 
 
 

 

 
Tips Et godt sted at starte er alle de clipart-eksempler som følger med Corel DRAW®. Mange af 
disse kan tilpasses og anvendes til broderi. 
 

Konvertere Bitmap artwork 
Magic Wand-værktøjet gør det muligt automatisk at stingsætte dele af et billede eller udvalgte 
former.  Med samme teknik kan du anvende Auto Digitizer som konverterer et helt billede til 
broderi og afgør hvilke stingtyper som er passende at bruge. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Tips Kom i gang med at se alle billedeeksemplerne som medfølger ved installationen af 
BERNINA Broderi Software. Prøv at brodere i hånden for bedre at forstå de forskellige teknikker 
og eventuelle begrænsninger. 
 

Næste skridt 
 

Anvend denne funktion for 
at konvertere mellem 
artwork og broderi. 

Anvend Magic Wand 
og Auto Digitizer for at 
se formerne igen i 
artwork og konvertere 
til broderi. 
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Hvis du er nået hertil, så behersker du allerede 90% af teknikkerne som de fleste som broderer 
behøver. Hvis du følger næste skridt, vil du prøve det sværeste af teknikkerne. Manuel 
stingsætning. Men du behøver ikke dykke så dybt af én gang. Start med et enkelt projekt, og 
arbejd dig opad til mere komplicerede stingeffekter. Læs gerna i Reference Manual eller via de 
mange online-kilder. 
 
 
 
 
 
 
 
 
 
 
 

 
Specielle broderi-egenskaber 
Når du behersker manuel stingsætning, så kan du bruge det komplette udbud af stingtyper og 
effekter som BERNINA Broderi Software tilbyder. Mange af dem kender du til, når du nu 
allerede har redigeret eksisterende designs med forskellige formål. 
 
 
 

 
Nogle af alle de teknikker som findes i BERNINA Broderi Software: 
►       Frihånds-broderi 
►       Mønsterstempel, konturer og fyldesting 
►      ’ Håndbroderede’  bårder og fyldesting 
►       Applikation 
►       Korsstygn 
►       Knaphul 
►       Multi-dekoration 
►       Quilting 
►       Ophøjet broderi 
 
Læs mere i Reference Manual eller i de mange online 
kilder. 
 
 
 

Sjovt og nemt broderi 
 
Du kommer til at lave meget flot arbejde med din 
BERNINA maskin og BERNINA Broderi Software. Med 
denne disse ting, har du alt du behøver for at skabe 
professionelle broderier i topkvalitet. Det eneste der 
mangler er viljen til at komme i gang. 
Kom  i gang med at anvende alle de medfølgende broderi-designs og clipart. Føler du dig 
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usikker, gå da tilbage til det grundlæggende. Og når du vil udvide din viden, brug da alle 
eksemplerne og bliv stærk i at bruge programmet. 
Vi ønsker dig alt det bedste. Og at du får mange gode timer! 
 
 

BERNINA Broderi Software Quick Reference -  Hurtigt overblik 
 
I BERNINA Broderi Software er CorelDRAW® Essentials X6 integreret til et enkelt program. I 
denne quick Reference kan du detaljeret se hvilke funktioner og værktøj som er tillgængelige i 
Embroidery Canvas og i Hoop Canvas. Alla muligheder findes ikke i alle versioner af V7. Du kan 
læse mere i Product Feature List i Reference Manual. 
 

Embroidery Canvas værktøjsfelt 
 
I Embroidery Canvas arbejdstilstand finder du nedenstående værktøjsfelt. Ikke alle værktøjer 
findes i alle versioner af V7. 
 

Canvas værktøjsfelt 
Der findes tre forskellige arbejdstilstande i BERNINA Broderi Software som vælges via Canvas 
værktøjsfelt. 
 

Importér, redigér eller Lav vector artwork/billeder som 
udgangspunkt for et broderi, at stingsætte manuelt eller automatisk. 
   
Sting och redigér broderidesigns. Viser både broderi og artwork. Se 
designet i 3D simulation. 
 
Se på og redigér  multi-hoopings/flere opspændinger i rammer. Om 
broderiet er for stort eller indeholder flere designs som er spredt ud, 
og deles op i flere opspændinger i rammer. 
 
Vis eller luk hvert broderi-objekt.  
 
Konvertér Broderi til Artwork: Konvertér valgt/markeret 
broderiobjekter til vector artwork. 
 
Konvertér Artwork till Broderi: Konvertér valgt/markeret vector- 
eller bitmap-artwork till fylde- eller kontursting. 

   

 
Notér For en komplet beskrivelse af CorelDRAW® Essentials X6 værktøjet, læs mere i den 
elektroniske User Guide som findes via Windows Start > Programs-gruppen. Alternativt, 
anvend onscreen help. Tillgænglig via Graphics logoet > Help menuen. 
 

Hoved værktøjsfelt 
Dette værktøjsfelt inkluderer værktøj til at åbne og lukke designs 

Åbn nyt tomt design. 
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Åbn et tidligere projekt. 

 
Gem nuværende projekt. 

 
Udskriv. 

 
Se hvad der bliver udskrevet. 

 
Send design til BERNINA design card, USB eller BERNINA 
broderimaskine. 
 
Samme som Edit > Cut / klip. 

 
Samme som Edit > Copy / kopiér. 

 
Samme som Edit > Paste / indsæt. 

 
Samme som Edit > Undo / tilbage. 

 
Samme som Edit > Redo / frem. 

 
Samme som File > Insert Embroidery / indsæt broderi. 

 
Samme som File > Insert Artwork / indsæt artwork/billede. 

 
Adgang til underprogram – Portfolio, Cross Stitch og Quilter 
 
Adgang til indstillinger af markerede broderiobjekter eller til 
forudindstillinger hvis intet er markeret. 
 
Sæt stingeffekter på valgt broderi-objekt eller som forudinstillinger 
hvis intet er valgt. 
 
Adgang til arbejdstilstands indstillinger som gælder rammer og 
faneblade. 
 
Ændre fra metersystem til tommer. 

 
 
Via eller luk oversigtsvinduet. Anvend for at zoome og for at se 
miniature af det nuværende design.  
 
Vis eller luk Color Film-vinduet. Ændre på rækkefølgen eller farveblok 
i designet. 
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Vis eller luk Carving Stamp-vinduet. Anvend grundindstillinger eller 
tilpasse mønstre for at lave et  mønster af nålestik. 
 
Vis eller luk Morphing Effect-vinduet. Lav ændringer i konturer og 
fyldesting. 
 
Vis eller luk StumpWork Border-vinduet. Anvendes sammen med 
StumpWork værktøjsvindue.  
 
 

View /Se Værktøjsfelt 
Dette værktøjsfelt indeholder værktøj for visning af designet. Læs mere i Viewing Designs i 
Reference Manual. 

 
Vis eller luk 3-D simulation. 

 
’Dimm’ baggrunden for at vise stingene mere tydeligt ved 
stingsætning. 
 

Vis eller luk broderisting. 

 
Vis eller luk nålestik i broderiet. 

 
Vis eller luk forbindelsesting mellem broderede objekter. 

 
Vis eller luk alle bitmap/artwork som findes i designet. 
 
Vis eller luk alle vektor/artwork som findes i designet såsom 
CorelDRAW® clipart. 
 

Vis eller luk alle stumpwork under-designs som findes i designet. 

 
Vis eller luk baggrundsstof/ i alle applikerede objekter i designen. 
 
Vis eller luk rammen. Højreklik for indstillinger. 

 
Vis eller luk arbejdsvinduets hjælpenet. Højreklik for indstillinger. 

 
Vis eller luk arbejdsvinduets linialer og guider. Højreklik for 
indstillinger. 
Simulerer hvordan broderiet sys enten som en ’tegnet’ eller ’virkelig’ 
film. 
 

Farvepalet 
Dette værktøjsfelt indeholder en palet af trådfarver samt forskellige værktøjer til at 
vælge/markere, applikere, og skifte mellem farverne. Læs mere i Thread Colors & Charts i 
Reference Manual. 
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Vælg en tidligere brugt farve, og anvend den til nuværende objekt. 
 
Applikér den nuværende udvalgt farve på broderiobjektet. 
 
 

Viser den nuværande valgte farve  
 
Går igennem kombinationer af anvendte farver. Højre- eller 
venstreklik. 
 
Adgang til Color Wheel for at teste kombinationer af nærliggende 
farver. 
 

Søg efter matchende tråd fra forskellige fabrikater, og vælg for at at 
anvende. 

 

Sting værktøjsfelt 
Dette værktøjsfelt indeholder en masse forskellige bas-konturer og fyldesting men også dem 
med mere dekorativt udseende. Det indeholder også visse stingeffekter som kan applikeres. 
Venstreklik på ikonet for at vælge stingtype. Højreklik for at komme til indstillinger. Læs mere i 
Outline & Fill Stitches i Reference Manual. 
 
Outlines/Konturer 
 

Lav en enkel række med sting med en kontur – Anvendes til kanter 
eller detaljer. 
 

Lav en bredere kontur ved at stingen sys tre gange – anvendes til 
kraftige kanter eller detaljer. 
 

Lav traditionelle efterstings-sømme – en gammel tilpasnings 
stingtype som anvendes til flotte kanter. 
 

Lav traditionelle kontur-sømme for detaljer såsom stilke og 
blomsterranker. 
 
Lav en endnu bredere kantsøm med valgbar bredde. 
 
Lav en forhøjet satin-kantsøm – kan anvendes med trapunto for 
quilteeffekter. 
 
Lav  lange ri sting som fine kantsømme. 

 
Lav ornamentale kantsømme/’håndbroderi’. Navnet Blackwork 
stammer fra traditionelt sort silke-broderi. 
 

Lav ornamentale kantsømme/’håndbroderi’. Du kan vælge  
mønsterstørrelse og afstand. 
 

Lav ornamentale kantsømme/’håndbroderi’. Vælg ud fra et 
mønsterbibliotek. 
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Fills/Fyldesting 
 

Lav fyldesting for større, uregelmæssige former. 

 
Lav fyldesting for mindre områder. 
 
Lav forhøjede områder – kan applieres på bokstaver eller anvendes 
med trapunto for quilteeffekter. 
 

Lav fantasifulde fyldesting som stadig har holdbarheden som alm. 

 
Lav 3D mønstereffekter med vredet/drejet fyldesting. 

 
Lav et spiral mønster fra centrum på et valgt, fyldt objekt. 
 
Lav broderi som følger objektets konturer, resultatet bliver en lys-og-
mørk skyggeeffekt. 
 

Lav fyldninger for blackwork designs. Navnet stammer fra 
traditionellt sort silke-broderi. 
 

Lav franske knuder – traditionelt hvidt-på-hvidt broderi oftest syet 
med bomuldstråd på hvidt linned. 
 

Lav et blonde look med öppna ”spaljé”-lignende mønster. 
 

Lav dekorative fyldesting. Vælg fra et mønsterbibliotek. 

 
Lav åbne mønster-fyldninger med korssting som passer til standard-
hjælpenettet for hele designet. 
 

Lav fyldning med bølgende sting som fylder en hele overfladen 
indenfor kanterne. 
 

Lav kraftigere bølgende sting med stilkestings-konturer. 
 

Lav kraftigere bølgende sting med efterstings-konturer. 
 
 

 
           Effekter 

 
Forstærk og stabilisér objekt med underliggende sting. 
 
Lav ujævne kanter og skygge-effekter, eller lave spraglet tekst. 

 
Lav  cirkulære mønstre med visse stingtyper. Stingen lægges fra 
Yderkanten med retning mod centrum. Centrumpunktet kan  
flyttes. 
 

Lav bølgeformede sting med en digitized guidelinje – stingen bliver ved 
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med at have samme tæthed. 
 
Transform / Ændre værktøjsfeltet 
Dette værktøjsfelt indeholder alle de værktøjer du behøver for at vælge/markere, 
omstrukturere, ændre størrelse, og spejlvende dit broderiobjekt i Embroidery Canvas. Læs mer 
i Arranging & Transforming Objects i Reference Manual. 
 

Klik for at vælge/markere et objekt eller lave en markering omkring 
objektet. 
 

Vælg en uregelmæssig flade eller form – lav referencepunkter rundt om  
objektet. 
 

ændre form på det markerede broderiobjekt eller tekstobjekt. 
 
 
 
Forøg/formindsk størrelsen på det markerede objekt i 20%-trin. 

Stygnantalen  
 

Bliver automatisk tilpasset 
 
   
 
 

Spejlvend det markerede objekt horisontalt eller vertikalt. 
 
 
 
 
 
Rotér det markerede objekt i 45°-trin mod- eller med uret. 
 
 
 
Rotér det markerede objekt till bestemt gradtal, positivt eller negativt. 

 
Forskyd det markerede objekt til bestemt gradtal, positivt eller negativt. 
 
 
 
Ændre indstillinger for den præcise placering af det  markerede objekt. 

Använd 
 

Ændre størrelsen på objektet eller hele designet  
Ved at skrive den bestemte bredde eller højde, 

eller  
Eller i antal %. Anvend Aspect Ratio-låsen for at 
Bibeholde formatet. 

 



BERNINA® Embroidery Software 7      
Quick Start Guide 

 

20 
 

Zoom værktøjsfeltet 
Dette værktøjsfelt indeholder alle de værktøjer du behøver for at zoome og panorere. Der 
findes også andre zoom grund-indstillinger via View-menuen. Læs mere i Zooming & panning i 
Reference Manual. 
 

Venstreklik for at zoome ind, højreklik for at zoome ud, eller brug 
en ’zoom-box’. Genvejsknap <B> kan også anvendes. 
 
 
 
Zoom Factor: vælg nogle af de mulige zoom-værdier fra drop-ned-listen  
eller skriv selv en ønsket værdi og tryk Enter. 
 
 
 
 
 
Træk for at panorere over designet med høj zoom-faktor. 
Genvejstast <P> kan også anvendes. 

 
 

Embroidery Canvas værktøj 
 
I Embroidery Canvas arbejdsvindue finder du et værktøjsvindue med nedanstående beskrevet 
værktøj. Den vil være permanent synlig til venstre. Værktøjsvinduet indeholder et antal 
rullelister med værktøjsgrupper:  
 
Edit/Redigér værktøjet 
Dette indeholder alle de værktøjer du behøver for at redigere broderi-designs i Embroidery 
Canvas mode. 
 

Klip hul i fyldt objekt. 
 

Fjern hul fra markert objekt 
 
 

Indsæt stingvinkel i slutningen af objektet med eller uden hul. Højreklik     
for indstillinger 

 

Fjern stingvinkel fra slutningen af objektet med snoede sting. 
 
 

Forstærk konturer ved at sy i modat retning. 
 
Automatisk sekvensvalgte konturer for effektiv brodering. 
 
Lav farveovergange det valgte objekt. 
 
 

Fyld hul i det markerade objekt med forvalgte stingtyper. 
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Automatisk kontur lægges på det markerade objekt med singel-, trippel- 
eller        Satinsøm. 

 

Anvendes i sammenhæng med forhøjet satin for at lave et forhøjet  
”quiltet” udseende. 
 

Deler monogram op, applikationer, tekst, og blackwork sømme i  
mindre komponenter så at de forskellige objekter kan redigeres. 
 

Fjern uønskede sting som ligger under objekt eller tekst. 
 
Fjern uønskede sting som ligger under et applikations-objekt. 
 
 
Placér sting-markøren ved et valgt sted for at sætte ind. 
 
 

Auto Digitize/automatisk stingsætnings-værktøj 
Disse værktøjer anvendes for automatisk stingsætning af artwork i Embroidery Canvas mode. 
Læs mere om Automatic Digitizing i Reference Manual. 

 
Automatisk stingsætning af færdigt bitmap artwork/billede. 
 
Automatisk stingsætning af fyldte flader i et vector eller bitmap  
artwork/billede. 
 

konvertér et fotografi (sort-hvidt eller farve) til broderi. 
 

 
Digitize / stingsætningsværktøj 
Disse værktøjer anvendes til manuel stingsætning i Embroidery Canvas mode. Højreklik for at 
gå tll indstillinger. Læs mere om Digitizing Methods i Reference Manual. 
 

Stingsæt et ’åbent’ broderiobjekt. 
 
Stingsæt et ’lukket’ broderiobjekt. 
 
Tegn en broderet kontur med frihånd (’åbn’) direkte på skærmen med 
valgt stingtype. 
 

Tegn på et broderet objekt med frihånd (’lukket’) på skærmen  
med valgt stingtype – kontur eller fyldesting. 
Stingsæt kolonner med snoede sting. 

 
Stingsæt elipser eller cirkler til designet. 
 
Stingsæt rektangler eller kvadrater til designet. Tryk <Ctrl> 
for at lave en kopi af kvadratet. 
 

Lav broderet tekst direkte på skærmen. 
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Lav et personligt monogram ved at anvende et utal af færdige 
skrifttyper, bårder, rammer og ornamenter. 
 
Konvertér/digitalisér  lukket objekt til applikationer med alle  
sømmene. 
 

Konvertér åbent objekt til applikationer fra et eller flere andre  
objekter. 
 
Stingsæt et enkelt knappehul med alle de nødvendige sting. 

 
Stingsæt en række af knaphuller med alle de nødvendige sting. 
 
Digitalisér PunchWork designs som anvendes sammen med  
BERNINA Punch Tool for roterende gribere. 
 

Placér individuelle/færdige mønstre i designet, vælg fra et mønster-  
bibliotek. 
 

Frihands-indstillinger værktøjsfelt 
Når Frihånds-værtktøjet er aktiveret, bliver dette værktøjsfelt vist. 

 
Anvend ’Show Guide’ for at forenkle frihånds-digitizing  - den giver   
mere 
kontrol over frihands-tegningen end standart markøren. 
 
Anvend ’Guide Inner Circle Radius control’ for at stille størrelsen på  
den indre cirkel når man anvender frihånds-digitizing guiden. 
 
Anvend ’Number of Guide Circles control’ for at vælge antal cirkler 
for frihåndstegningen – hvis den inderste cirkels radius er 2 mm, så får  
man yderligere en cirkel med et offset på 2 mm. 
 
Anvend ’Smoothing control’ for at indstille i procent hvor tæt den ligger       
på originalen . 
 
 

StumpWork værktøj 
StumpWork værktøj i værktøjsfeltet. Det indeholder alle de værktøjer man har brug for når 
man laver stumpwork. Læs mere om Stumpwork embroidery i Reference Manual. 
   

Lav stumpwork-kanter i det valgte objekt. 

 
Digitalisér en åben stumpwork-kant ved at anvende en stingsat kontur    
med nuværende indstillinger. 

 
Digitalisér en lukket stumpwork-kant ved at anvende en stingsat  
kontur med nuværande indstillinger. 
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  Åbn/cut en lukket stumpwork-kant for at få en åbning – til  
  ståltrådsenderne. 

 
  Lav en ståltrådslinje ved at bruge en stingsat kontur med  
  nuværande indstillinger. 

 
  Lav et stumpwork under-design fra valgt/markeret objekt som  
  inkluderer broderi med en stumpwork-kant. 

 
  Se og redigér valgt stumpwork under-design. 

 
  Gem stumpwork under-design som en separat design fil. 
  
      
 
     
Mirror-Merge værktøj 
Dette værktøj anvendes til at kopiere og konvertere et broderiobjekt i vertikal og horisontalt 
retning. Læs mere om Mirroring objects i Reference Manual. 

 
Dublikér og spejlvend horisontelt og læg flere objekter sammen (tilvalg). 
 

 Dublikér og spejlvend vertikalt og læg flere objekter sammen (tillval). 
 
Dublikér og spejlvend objektet omkring et centerpunkt. 
 
 
Dublikér valgt objekt omkring et centerpunkt. Ændre instillingerne i  
Mirror-Merge instillings- og værktøjsfelt. 
 

Dublikér og spejlvend objekt omkring et centerpunkt . Ændre 
indstillinger i Mirror-Merge indstillings- og værktøjsfelt. Dette værktøj  
bliver synligt når ’Wreath Tool’ er aktiveret. 
 

Vælg det ønskede antal wreath punkter. Vælg et lige tal for at  
aktivere kaleidoskop. 
 

 
Omrokér  
Disse værktøjer anvendes for at redigere et objekt uden lige linjer, dele og spejlvende objektet i 
Embroidery Canvas . Læs mere om Arranging & Transforming Objects i Reference Manual. 
      

Kombinér flere objekter til ét objekt, ved at gruppere. 
 
Del et objekt op til flere objekter ved at gruppere. 
 
Lås valgt objekt op for redigering. 
 
Lås alle objekter for redigering. 
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Flyt valgte objekter til venstre. 
 
Flyt objekter vertikalt. 

 
Flyt valgte objekter til højre. 
 
Flyt valgte objekter til top. 

 
Flyt valgte objekter horisontalt. 

 
Flyt valgte objekter til bunden. 

 
Centrer horisontalt og vertikalt. 

 
Fordel tre eller flere valgte objekter horisontalt. 

 
Fordel tre eller flere valgte objekter vetikalt. 
 
   

    
Color Film værktøjsfelt 
Dette værktøjsfelt er findes i Embroidery Canvas. 
 

Se de individuelle objekter i forhold til syrækkefølgen. ’Drag 
and drop’ objekt for at ændre på syrækkefølgen. 
 
Flytte valgt objekt bagud /fremad i syrækkefølgen. 
 
 
 
 
Flytte valgt farve bagud / fremad en i syrækkefølgen. 
 
 
Flytte valgt objekt til start / slutpunkt i syrækkefølgen. 
 
 

 
Ændra rækkefølgen på objekterne. 

 
Ændre rækkefølgen af blok med samme farver. (For at beholde  
separate farveblok, anvend Color Film.) 
 
 

Multi-Hooping toolbar 
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Dette værktøjsfelt finner du i Hoop Canvas läget. Läs mer under Hooping Design i Reference 
Manual för detaljer. 

 
Tilføj en ny ramme multi-hooping layoutet. 
 
Placér en ny ramme til højre forden valgte ramme. Den tillader 10 mm 
overlap mellem rammerne. 
 

Placér en ny ramme ovenfor den valgte ramme. 

 
Få 4/8 rammer rundt omkring den valgte ramme. Den tillader 10 mm 
Overlap mellem rammerne.  
 
 
 
Digitalisér en eller fler guider/markeringer i et multi-hoop layout for  
at dele objektet op mellem rammerne. 
 

Fjerne den valgte ramme fra layoutet. 
 
Beregn/planlæg rammer udfra det nuværende layout. 
 

      
 

 
 
   
 
 
 

 
 

 
 
   
   
   


